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NewLogOSH is a professional amateur radio logging software designed and running
on all Microsoft Windows platforms, e.g. Vista / W7 / W8 / W10 /W11. This software
has been under development for a few years and the author ( IZ4OSH ) provides this

software for FREE only radio amateurs as such will use it. 
Though NewLogOSH is a newborn logging software, it has a clear lean on DX in both
HF and VHF with full premium monitoring like DXCC, IOTA, WAZ etc. and includes

all the features you would expect from good quality DX recording software….. 
This software is completely free to download and use without losing any of the

programs features and without limitations of any kind. You are free to distribute it on
an individual basis, as long as all original files are intact and unmodified in any way,
and you are not charged for it. Any paid distribution is prohibited without specific

authorization from the author. 

Alessandro Azzolini, IZ4OSH 
NewLogOSH © Copyright, iz4osh 2020-2023

A year and a half has passed since the first version made public, in the middle of these months
many things have changed, development continues unabated.

Today NewLogOSH stands among the peaks of the Top Software.
The Software has been tested in all Microsoft Windows platforms such as:

Vista/W7,W8,W10,W11



First time installation
This specification is aimed at those who have never installed the software before.

Preliminary stages:

1) Before installing NewLogOSH make sure you have downloaded the necessary components from
the website (The latest version of NewLogOSH, Omni-Rig V1.19, Digital Express)

NB: it is essential to use the official version of Omni-Rig 1.19.

Installation process
Follow this step carefully for proper installation

1-Install Omni-Rig

2-Install NewLogOSH (C:\NewLogOSH\)

3-Install Digital Express (C:1NewLogOSH\DigitalExpress\)

At the end of these installations restart the PC for the correct registration of the installed modules.

NB: For some versions of Windows after installation it may be necessary to start NewLogOSH as
administrator.

First configuration
Access the module (MyInformation from the Setup menu)



The operator's data must be entered on this panel, all fields must be filled in correctly, otherwise the
program will malfunction.

Follow the instructions carefully:

To enable data entry click on the top right (Add New) once this is done you can now enter your
data, at the end click on the Save button.

NB: To use the LotW, Eqsl, HamQTH services, you must be registered with these services and have
the LoTW certificate available.

Normally in the LoTW field the Username and Password are the same as those used to access your
ARRL profile in LoTW, the same thing also applies to HamQTH and Eqsl.

Once you have completed filling out the form after saving, the data will go to the upper grid, once
this is done Remember to put the check in the upper left (Active ID)

Longitude and Latitude are calculated automatically by the software when the Locator is entered.

Now we can close NewLogOSH and Restart it,

if the data has been entered correctly on the map, you will notice the exact position of your locality.

If the HamQTH data is not entered it will not be possible to download the dx station data!



Now the software is ready to be used.

Control Panel and Features

Starting from the left we find: Contextual Menu, Digital Ways, Personal Info,
About,Help,Telnet,HamQTH,Telnet and Wsjt Map,Online Logs,CwReader,Digital Express, Rotor

Control.

Setup RTX Omni-Rig settings, Rig1 for rtx1 Rig2 for rtx2

WL_Cty.data file is a text file that is downloaded for smooth running of country routines etc. For
the inexperienced, I recommend performing this download automatically by clicking Download and

import wl_cty.dat file.



Open Log (opening the Logger where your QSOs are saved

Save Your DB: This is a function that allows you to save your database after importing your
records. This function is very practical when you need to save the database without having to export

the records and import them again, when you save the DB you also save the data entered in the
MyInformation table. When there will be updates on the new versions, just save the DB on the
Desktop, run the software update then drag the file (Newlog.db into the program installation

directory). There are two advantages in this operation, 1-if something should happen to the PC, the
Logger data is not lost. 2 you don't waste time having to import your Records especially for those

who find numbers higher than 50 thousand QSOs)

Download NewLogOSH (Here you can check if a more recent version of the installed program is
available online.

Digital Contest Mode

to activate this function, after having opened it, click on Settings and select the input audio.

Putting the flag (Active rtx1 or Active rtx2 will set the focus on the RTX that will have to go on
transmission). Band RTX will be used to memorize the bands for the Contest sessions example: (the

portions of the band in digital modes such as FT8 and FT4 are different from normal daily
operations). This simplifies the switching speed especially if two RTXs are used Example (RTX1

for FT8, RTX2 for FT4) the same thing happens for some Contests in CW, RTTY, PSK. This panel
can also be used in daily operations by memorizing the bandwidth portions as described above.



Memorize Bands
Position the mouse pointer over a button and click the right mouse button, a window will open

where the portion of the band concerned will be inserted

Example if we wanted to memorize the portion of the 20m write as seen in the picture and click OK
at this point the band is memorized.

The same operation also takes place in the Main panel where the RTX commands are located.

N1MM Bridge Setup

This function allows you to use all the functions of n1mm and log the records directly into the
NewLogOSH Logger. Example (During the Contest sessions each registered contact will be sent to
the Database) All operations in digital, CW, RTTY etc. This function has also been tested in daily

operations in different modes, everything works regularly without any errors. To set up the N1MM
side, open the top menu: Config, then click Brodcast Data



Here put the flag on Contacts and click Ok.

Configuration of the CAT.

Here are two ways to do this option NewLogOSH and N1MM depends on the type of interface you
use.

Option1: for all those interfaces that support two and more data communication CATs example
(Micro Keyer 2/3)



As you can see from the photos, there are two data communication ports ranging from the RTX to
the distribution depending on which software is used. Example (COM10 RTX1, COM11 RTX1)

This means that the same RTX will be connected to two different Loggers and manage each
function autonomously. In this case the COM10 is configured for NewLogOSH and the COM11 for

N1mm. Each band or mode change operation the two Loggers follow each other without any
margin of error.

Option 2 (this option is used for those who use only one communication port or a simple home
interface) Using this option it is sufficient to configure the communication port with n1mm, having

done this, once the two Loggers have been started, N1mm will manage NewLogOSH as regards
data sent to the station Log.

Picture below with Configuration Option1



digital ways

Here it will be possible to configure the digital modes FT8 FT4 let's see how: Clicking on the item
Setup Ruter Wsjt a panel will open which must be filled in correctly.

As you can see from the photo this is the correct configuration to be able to run WSJT or JTDX

When performing a setting operation Remember to always restart NewLogOSH because these
settings must be recorded in a registry file.



WSJT side configuration

The Radio must be configured based on which Omni-Rig channel has been configured RTX1 or 2
Configure as shown in the photo.



For the configuration of the UDP bridges, perform the configuration as shown in the photo.

The same configurations must also be carried out on JTDX





After performing these setup operations, close WSJT or JTDX and restart NewLogOSH at this point
you will notice that the WSJT Decoder List window will be populated.

By clicking on a callsign that you want to connect, the cursor on the JTDX or WSJT spectrum will
position itself in the audio passband portion as seen on the Freq list

  



telnet

When telnet is up and running the map will populate showing the exact spots where the DX stations
are located



the red dots are the data arriving from Telnet, the yellow dots are the data arriving from WSJT or
JTDX, the blue dots are the stations already present inside the Logger (double station for the band

where you are).

From the Color menu of the Map it is possible to customize the color of the points. From the
Settings menu it will be possible to activate other functions such as the equator line, sundial, etc.

HamQTH
Clicking HamQTH on the top menu you will be able to access the website directly, after logging in 
you will be able to do research on the interested stations.

Telnet and WSJTMap
Map opening when closed.

NB: to memorize the position of the map or of other windows click on the X in the top right corner
after positioning the form, closing the window in this way the position will be memorised,
subsequently when the same window is restarted it will open in the position that has been
memorized. (This applies to all project windows apart from the WSJT Decoder List and

configuration windows).

Online Logs
Online log means Lotw,Eqsl. Let's see what configurations we need to perform.

LoTw

When you open the Lotw window for the first time you have to do three things:



1 Go to select LotW Download directory which is inside the directory where NewLogOSH was
installed, LotW reports will be stored in that location. This is used to be able to view the input

records if there are problems such as Grids cqzone ituzone etc.

2 Select the directory where TQSL.exe is installed (when you send records to Lotw these records
are signed by your own certificate which was sent by ARRL Lotw. Without any certificate you will

not be able to send records).

3 Indicate your callsign in Lotw Callsigns

NB: NewLogOSH is a Logger recognized by ARRL

See web address: https://lotw.arrl.org/lotw-help/submitloggingapp/

Data Send Function:

After having recorded one or more QSOs in the log you will notice that the record sending flags are
filled in automatically, at this point to send the records, open Lotw Upload/Download and click

CREATE Lotw Export File in NewLogOSH and Upload to Lotw. All records with active flags will
be sent and the sending dates will be shown on the log.

To download the records and synchronize them with the records inside the Log, follow these steps:

Select a date, then click Download Lotw QSL Information And Sync Into NewLogOSH

At this point wait for the records to be downloaded and synchronized. The sync time goes according
to the number of records you are downloading. At the end of this operation it will be possible to

close the form.

EQSL

If the data in the MyInformation form has been filled in correctly, after having registered one or
more QSOs Open EQSL Upload/Download and click Create eQSL Export and Upload to eQSL, at

this point all registered records will be sent to eQSL. NB: WHEN IMPORTING I

https://lotw.arrl.org/lotw-help/submitloggingapp/


RECORDS COMING FROM OTHER LOGGERS THE PROGRAM WILL ASK IF YOU WANT
TO ADD THE FLAG TO THE EXPORT OF CONTACTS, IF THE PREVIOUSLY IMPORTED
CONTACTS HAVE ALREADY BEEN SENT TO EQSL YOU MUST INDICATE NO TO THE

FLAG, EQSL WILL REFUSE ANY ATTEMPT TO DUPLICATE THE RECORDS AND
THEREFORE YOU WILL ARRIVE ERROR WARNINGS BECAUSE THE RECORD IS

PRESENT IN THEIR DATABASE.

To download the available records Click Download from eQSL and Sync in log. At this point all
records available for synchronization will be downloaded. Wait for the synchronization to finish.

Once this is done, the form can be closed.

CwReader

To make this option work, you need to install two external programs (CwGet and CWType)

After configuring the Path in the CwPath panel select the input audio (input Soundcard) At this
point close CwPath and close CwOSH and restart the process by clicking on the CWReader main

panel

On restart it will appear in these conditions.



This program does not replace the Cw with the classic palettes, etc., but helps those who have to fill
in many gaps to understand the world of the telegrapher. In contest operations or QSOs with dx

stations it helps beginners to understand what the dots and dashes are.



Digital Express

Digital Express is a program that implements the functions of MMVARI PSK31 and other digital
modes. Contains an independent database for contest operations. Inside you will find a broad

explanation of its operation and the configurations to be carried out. Macros are programmed from
the panel that opens when you right-click a button





Digital Express is a good quality program you need to know its functions well, to do this it should 
be used and tested in all its functions. The beta testers are enthusiastic and it has been tested in 
several sessions in the RTTY Contests, all processes work correctly. I advise.

Rotor control



Rotor Control is a control that allows you to rotate the antenna through a control interface
connected to your Rotor's controlBox. This setup works for the Yaesu G1000DXC, for other rotors I

haven't had the chance to test. For this setup to work, you need the following components:

1 FUNBOX WINROTOR PLUS interface and control SOFTWARE.

  

in the Options menu select Tracking Mode

Then select PstRotatorAZ



PstRotatorAZ configuration

open the setup and go to Trackers Setup and select DXLOG.Net



A window like this will then open:

Then put the Flag on the Azimuth item, click save and close.



Prepare the program for TCP Client, if things went well PsTRotator and WinRotor PLUS are
communicating with each other. At this point open Rotor Control, Write a call Call in the

NewLogOSH main panel,

By subsequently clicking on LooKup, the latitude and longitude data are sent to the Rotor Control
by filling in the Azimuth box and by clicking on the Start button, the data is sent to the two

Controllers and the antenna will position itself in the direction of the Azimuth box.

The latitude and longitude control of the right stations reads the positions aiming at the center of the
grid, then after clicking LooKup based on the real position of the right station it will correct the

degrees radians. The accuracy is very high.



QRZ.COM XML UPLOAD

This service requires a QRZ subscription ( XML Lookup and higher )
QRZ Log supports 2 types of uploads to the QRZ Log database.

One is to upload an adif file that contains multiple qso ADIF records ( Up to 1000 records ).
The others are qsos that are uploaded as soon as the qso is logged in the logger.

Deleting or recovering qsos via this interface is not supported.
Registry name, ID and key are required and are available from your qrz

logbook in the settings window for each logbook.
You will need to add your currently used logbooks in the Setup window.



QRZ SETTING



1: Open your browser and log in ( www.qrz.com )
2: access your online log settings by clicking (QRZ LOGBOOK) You should find it on the Home as

soon as you log in with your credentials
3: Now click on the button you find (QRZ LOGBOOK)

4: Green button
at this point you will find yourself in your qrz logbook.

5: click where you find written (settings)

Settings

http://www.qrz.com/


6: now you will be in the LogBook Info configuration page, and QRZ
LogBook API

7: Now open NewLogOSH and from the top menu (Online Logs) click
(QRZ)

open the qrz form, go to settings (click QRZ Setup)

QRZ SETUP

The setup page opens

In the boxes below enter the name of your logbook, logbook
and registry key

1: Logbook = LogBook Name
2: Log Book = LogBook Book

3: The key = LogBook Key
Now proceed to insert this data, to do this copy and paste the

information you find on the qrz settings page that you previously
opened.



1: copy the name of your Logbook that you find in LogBook info

 

LogBook Name
LogBook Book

Now enter your personal code (API KEY) you can find in QRZ
LogBook API

Click (Show to view your personal code and paste into Logbook KEY )

Now that the three boxes are filled in, click on the (Add) button in this
way the data will be entered into the database.



In the boxes (Urename and Password enter your qrz.com login
credentials)

Now close the form, close NewLogOSH and restart the program.

If your information was spelled correctly, reopen the program and
open qrz

You need to activate the qrz Logbook click (Active Logbook)

Wait (2 seconds, then click (View LogBook Status))

(Sometimes QRZ takes about ten seconds to send your data to
NewLogOSH, at this point I recommend closing the program and
restarting it. When everything is successful, the status of the Qrz

LogBook appears like this)



QSOs UPLOAD PROCESS
When making a QSO in FT, Cw, Rtty, SSB, Psk etc

this registers a QSOs the program automatically adds a tick (Y) inside the
database this means that the registered contact is ready to be sent to the QRZ

LogBook. Let's see how:

To automatically send the records (click : Create QRZ EXPORT FILE
IN NewLogOSH And Upload to QRZ LogBook)

By executing this process the program will view how many records
must be sent to QRZ, if one or more of these records are already



present in QRZ these records will not be sent (This happens because a
cross-check is performed in real time) at the end of the process

sending a box will open (View Results)

Click on the button to view the number of records sent

Manual Upload Process
In some cases it is necessary to send a certain number of records, for

example executed years ago, proceed as follows:

Open the logger in NewLogOSH, select the QSOs you need to send
and from the top menu LogOptions click (Export Selected QSOs) Save

the export file on the Desktop. Now Open QRZ

Open the path where the ADI file created by this button is located



After you have selected the Path click Upload QRZ LogBook

At this point the QSOs will be sent successfully.

NB: I recommend saving the ADI file in the directory where the
program was installed, inside there is a directory already created

(QRZ Report)

If for any reason while sending the QSOs the PC should be switched
off no problem inside the program installation directory it is found in

the ADI file created by the program which is called: (QRZLogbook) in
this file you will see the records sent.

The process explained for the Qrz module is the same that is used for
the Lotw module.

PROGRAM UPDATE
To the web page : https://newlogosh   logger   .com/  

In the Download section there is a button that allows you to update future Bulits.

1 Download the update

2 Run the installation in the same directory where the NewLogOSH_full Install program was 
previously installed.

With this process you don't need to rewrite your data and settings etc.

(In the directory where the program was installed there are two important files that you need to 
make a copy for greater security, (newlog.db and settings) by saving these two files on the desktop, 
if something goes wrong you are sure of being able to recover the log and the settings performed 
previously).

https://newlogosh.com/
https://newlogosh.com/
https://newlogosh.com/


NEW SUMMARY QSOs, DXCC Awards

To open the summary with details, open the Logger at the top is the command to start the program.

When the program opens, select your ADI file from the File menu for its analysis, when requested 
for the first time it will ask for it twice then subsequently the program will close automatically to 
record the Path of the file that has been selected.

Now you can start the table of contents and you will see it like this.





Select the year you want to view from the highlighted menu

Select the operating mode you want to inspect



At this point the program will autonomously carry out an analysis of the log adi that has been 
selected, highlighting the trend with the graphs.

From the Time Award Summary it will be possible to view the entire trend of the worked and 
confirmed DXCC.



To activate the DXCC Challenge and view the details, click on the TIME CHART at the top and 
select from the menu (DXCC challenge Point)

To view the errors present in the Log in the Options Menu select ( Show QSOs with unknown 
DXCC)



This information window will open:

As you can see, in the image above, an identification number (DXCC)
is missing from the contacts. To fix these records, open the Logger,

search for the matches of the records listed here and enter the missing
DXCC.

This problem can occur in cases where the dx station has never
confirmed the qso, or it could be a duplicate qso. To understand which
dxcc belongs to a dx station, write the call from the NewLogOSH main
panel and run the LooKup, at this point on the lower bar you can view

the dxcc number that will be written inside the logger and saved.

DXCC extension

From version 10.043.0 a few things have changed, the computerized
panel is now inside the setup menu.

Setup window:

here you will find most of the settings of the programmate



Radio Versus Setup

The old generation radios use a different protocol than the more
recent ones, sometimes it can happen that going in Rtty or Cw mode
these two modes RTX sees them as WC-R or PARTY-R by checking
one of the above boxes RTX when toggle the mode will do it right.

Frequency Setup



The frequency panel is used to determine the bandwidth that a
transmission should occupy in a given operating mode. Let's take the
FT mode as an example, in the bands established by the Band Plane

example: (20m, 14074.0 FT8 mode) here it will be enough to insert the
lowest and the highest frequency in the table, in this case it will be

14.074.0 in both cases, what does it mean? It means that when you go
to turn the VFO of your RTX as soon as you arrive in that portion of

the band your RTX will switch to digital mode ft8 or USB, in the main
panel of NewLogOSH you will notice that the program is already set
up for this operation and NewLogOSH is only waiting for you go to

the DigitalWays menu to start the Ruter ft.

ATTENTION

if we are trying to connect a dxSpedition in FT modes, in this case it
will be necessary to insert the example sample frequency (14.090.0) +

the split that dxSpeditions normally use, in this case it will be
necessary to write in the higher frequency (14.093.0). In this case the
dxSpeditions operating in F/H many times when hooking up a station

can split it even at the menu of one kilocycle therefore the correct
entry of the sample frequency will be: (14.0.89.0-14.093.0). If this step
is not performed, your RTX could change the emission mode when it
switches to split at the time of transmission. The above description

applies to all operating modes.

After configuring the frequency table, it will be possible to save it in your
archive.



COLOR SET

1. Here you can customize the colors of NewLogOSH, Telnet, These
are the colors that determine which stations are already

registered in the database etc. choosing a certain color for a dxcc,
as soon as it appears on the cluster or you write the call on the

main panel, it will show you the status of that area. (More details
can be viewed by opening the DxccLookup).



This function is activated from the contextual menu, subsequently
clicking on a Telnet call or writing a call on the Main of NewLogOSH,

the DxccLookup panel will populate and show in which bands that
particular Dxcc has been connected. Clicking on one of the X's will

show you the complete list of connected stations that are part of that
dxcc.



In the above case this is the state of the dxcc170 40m CW.

Inside the Contextual Menu is now the Utility Menu



digital ways

Added PSK mode



When you click on a call, the NewLogOSH main panel will populate
and show real-time DX station data. NB: always make sure that the

RTX focus is active before recording a QSOs, if the focus is not active
it will record the QSO without the working frequency and therefore it

will not be possible to send the record to LoTw, Qrz, Eqsl.

Focus On Focus Off

MODULE mmvari

Mmvari module reprogrammed in all its functions, therefore largely revised.
The emission modes are: Bpsk31, Psk62, PSK125, PSK250, RTTY_L, RTTY_U,
MFSK4_L MFSK4_U, QPSK31_L, QPSK31_U, GMSK31, FSK31, FSK31_W.

To make this module operational, click on the (SETUP) button at the top



The configuration form will open

In this module the Audio input and audio output channels are selected

The PTT COM port and RST or DTR line must be selected for PSK operation

To configure RTTY AFSK mode then run RTTY in USB or
LSB modes perform the AFSK configuration described above.

Note: running Rtty ssb way is not like running Rtty FSK by
ear you don't notice much, but over long distances the



difference is very noticeable, so I suggest always use FSK
whenever possible.

The substitutions table will contain the information needed to
compile the macro instructions.

Compilation of Macros

From the main MMVARI panel, click the right mouse button on the
macros corresponding to the button you want to configure, the macro form
will open, when you have finished entering the data necessary for sending

and the header which must have the click save button

When you click on a CALL from the MMV RX window, the call will be
sent to Main. Make sure you have active focus, at this point finished the

QSOs you can record the qso by clicking SAVE



NB: if data such as band frequency etc. are
missing after registration, it means that the
focus on the configured Rtx was not active.

I want to thank
Rick N2amg, Tom N1mm, Alex VA3NEA, Aki Ja1nlx, Jeff N7YG

73 ALE IZ4OSH
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